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PROIECTE – Exemple/Demonstratii
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PROGRAM DEMONSTRATIV == C++ ==



// program GRAF_Complet - generare sigla CNIV #include #include #include #include #include



 // biblioteca primitive grafice    



#define pi M_PI int gd , gm; int n , i , j; double r , x , y , xp , yp , fi; void main() { n=16 ; r =150; // testare n= 17, 25, 30 … gd = DETECT ; // initializarea modului grafic initgraph (&gd ,&gm , "C:\\Borlandc\\Bgi"); settextstyle ( 1,0,2); setcolor (4); // culoare desenare outtextxy (10,10," DESENARE GRAF COMPLET - GENERARE SIGLA CNIV"); // schimbare origine in mijlocul ecranului ( fara clipping)



setviewport ( getmaxx()/2, getmaxy()/2, getmaxx(), getmaxy(), 0); // se genereaza coordonatele varfurilor for(i=0; i 
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PROGRAM DEMONSTRATIV == OpenGL == // glsigla_CNIV.cpp ; desenarea siglei CNIV-background #include  #include  #include  #include  #include  #define PI 3.141592 int n=16; // numar de varfuri double radius = 100; // raza cercului glColor3d(0,0,0); // culoare glBegin (GL_LINES); // apel primitiva geometrica for (int i=0; i


PROGRAM DEMONSTRATIV == Java Script == // Vector Graphics JavaScript Library | Developed by WALTER ZORN // http://www.walterzorn.com/jsgraphics/jsgraphics_e.htm 








  



PROGRAM DEMONSTRATIV == Pascal/Delphi == program GRAF_Complet; uses GRAPH , CRT ; var gd , gm : integer; n , i , j : integer; r , x , y , xp , yp , fi : real ; ch : char ; begin writeln('Generarea unui GRAF COMPLET '); writeln('*************************** '); write(' Dati numarul de noduri n = ') ; readln( n ) ; write(' Dati raza cercului r = '); readln( r ) ; gd := DETECT ; gm:=VGAHI; InitGraph ( gd , gm , 'c:\tp\bgi'); Rectangle ( 1 ,1 , 639 ,479 ); SetTextStyle ( 1,0,1); OutTextXY (10,10,' GRAF COMPLET'); SetViewPort ( 320, 240, 600, 400 , false ); { se genereaza coordonatele varfurilor } for i := 0 to n-1 do begin fi := ( 2 * pi * i ) / n ; x := r * cos ( fi ) ; y := r * sin ( fi ) ; { se genereaza muchiile } for j := i+1 to n do begin fi := ( 2 * pi * j ) / n ; xp := r * cos ( fi ) ; yp := r * sin ( fi ) ; { se traseaza segmentul [(x,y) (xp,yp)] } Line ( round(x), round(y), round(xp), round(yp) ); end; end; ch := readkey ; CloseGraph; end.
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PROGRAM DEMONSTRATIV == C++ == // Emblema ANIMAFILM #include #include #include #include #include



 // biblioteca primitive grafice    



#define pi M_PI int gd , gm; int n , i , j; double r , x , y , xp , yp , fi; double round(double number) { double x = ceil(number)-number; if( number >= 0 ) {if(x 
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www.ad-astra.ro/marinvlada n=50 ; r =150; // testare n= 17, 30, 40 … gd = DETECT ; // initializarea modului grafic initgraph (&gd ,&gm , "C:\\Borlandc\\Bgi"); settextstyle ( 1,0,2); outtextxy (10,10," DESENARE EMBLEMA ANIMAFILM); // schimbare origine in mijlocul ecranului ( fara clipping) setviewport ( getmaxx()/2, getmaxy()/2, getmaxx(), getmaxy(), 0); // se genereaza coordonatele varfurilor for(i=0; i 


PROGRAM DEMONSTRATIV == Java Script == // Vector Graphics JavaScript Library | Developed by WALTER ZORN // http://www.walterzorn.com/jsgraphics/jsgraphics_e.htm



// Emblema ANIMAFILM   
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PROGRAM DEMONSTRATIV == C++ == // Program miscare cursor-cruce folosind tastele sageti // initial se misca aleator, apoi se apasa ENTER si cursorul va fi in mijlocul ecranului // apoi se poate controla cu tastele sageti //program cursor_cruce; #include  #include  #include  #include  #include  #include  #include  const enter=13 ;// codul ptr.  const sus=72 ; const jos=80 ; const dr=77 ; const st=75 ; //coduri ptr. tastele sageti; 0 si 72,... int gd , gm; int y, xu , yu; int lx , ly;// dim. cursor int xmin , ymin , xmax , ymax; char ch; int i; //{--------------------------------------------------} void DRAW_cursor (int xc , int yc) { moveto ( xc,yc ) ; linerel ( lx , 0 ); moveto ( xc,yc ) ; linerel ( -lx , 0 ) ; moveto ( xc,yc ) ; linerel ( 0 , ly ) ; moveto ( xc,yc ) ; linerel ( 0 , -ly ) ; } //{---------------------------------------------------} //begin { MAIN } void main() { gd = DETECT ; cout 
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www.ad-astra.ro/marinvlada //{ initializare dim. cursor } lx = ( getmaxx() + 1 ) / 50 ; ly = ( getmaxy() + 1 ) / 50 ; // { fereastra in care poate varia coord. cursorului } xmin = lx ; xmax = getmaxx() - lx ; ymin = ly ; ymax = getmaxy() - ly ; randomize(); int x = xmin + random( xmax - xmin + 1 ) ; int y = ymin + random( ymax - ymin + 1 ) ; setbkcolor( 1 ); setcolor ( getmaxcolor() ) ; setwritemode ( XOR_PUT); do{ //se deseneaza cursorul DRAW_cursor( x , y ); do{ delay(100) ; //{ se calculeaza noile coordonate } xu = x - lx + random ( 2*lx ) ; yu = y - ly + random ( 2*ly ) ; }while(! ( xmin 


ch = getch(); else ch = ' '; }while( ch != enter); //controlul cursorului cu tastele sageti; deplasare cu 7, respectiv 5 x = getmaxx() / 2; y = getmaxy() / 2 ;// centrul ecranului do{ DRAW_cursor(x,y);// desen cursor ch = getch(); //ptr. tastele sageti se fac 2 citiri ch = getch(); xu = x ; yu = y ; switch (ch) { case sus : yu = y-5; break; case jos : yu = y+5; break; case dr : xu = x+7; break; case st : xu = x-7; break; } DRAW_cursor(x,y); // se sterge cursorul x = xu ; y = yu ; }while(1); closegraph(); }



PROGRAM DEMONSTRATIV == Pascal/Delphi == Referinta: M. Vlada, “De la teorema lui Green la geometria computaŃională”, CNIV 2006, Conferinta Nationala de Invatamant Virtual, Ed. Universitatii din Bucuresti, pag. 105- 114



http://fmi.unibuc.ro/cniv/2006/disc/cniv/documente/pdf/sectiuneaB/1_3_vlada.pdf
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program Aria_Domeniu; { aria unui domeniu poligonal; reprezentare grafica} uses GRAPH , CRT ; type puncte = record x1, y1, x2, y2 : real ; end; var f : File of puncte; rec : puncte; nume : string[14]; gd , gm , n : integer; xp1,yp1,xp2,yp2 : integer; xmin,ymin,xmax,ymax : real ; Aria , sx , sy , sx1 , sy1: real; ch : char; sir : String; {------------------------------------------------------} procedure TRANSF ( xmin, ymin, xmax, ymax, x, y : real ; x0, y0, x1, y1 : integer; VAR xp, yp : integer ); { transforma coord. utilizator in coord. ecran } var
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www.ad-astra.ro/marinvlada dx, dy : real ; hx, hy : integer; begin dx := xmax - xmin ; dy := ymax - ymin ; hx := x1 - x0 ; hy := y1 - y0 ; xp := x0 + round ( ( x - xmin ) / dx * hx ) ; yp := hy - y0 - round ( ( y - ymin ) / dy * hy ) ; end; {------------------------------------------------------} begin { M A I N } writeln(' Aria unui domeniu poligonal si reprezentare grafica'); writeln(' Coordonatele punctelor trebuie sa fie memorate in fisier'); writeln(' NUMELE FISIERULUI DE PUNCTE : '); readln( nume ); Assign ( f , nume ) ; Reset ( f ) ; { se deschide fisierul de puncte } Aria := 0.0; xmin := 0 ; ymin:= 0 ; xmax := 1000 ; ymax :=1000; gd := Detect; gd := 0; InitGraph ( gd, gm ,'g:\soft\tp\bgi'); Rectangle ( 1, 1, 639, 479 ); SetTextStyle ( 1, 0, 2 ); { se citesc coordonatele din fisier } SetColor(15); n := 0 ; with rec do begin while not Eof(f) do begin read(f , rec ); if n = 0 then begin TRANSF( xmin,ymin,xmax,ymax,x1, y1,10,10,630,470,xp1,yp1); MoveTo ( xp1,yp1); sx1 := x1 ; sy1 := y1; sx := x2 ; sy := y2 { salvare } end else begin Aria := Aria + sx * y1 - x1 * sy ; sx := x2 ; sy := y2 ; { salvare } end; n := n + 1 ; Aria := Aria + x1 * y2 - x2 * y1 ; TRANSF( xmin,ymin,xmax,ymax,x1,y1,10,10,630,470,xp1,yp1); TRANSF( xmin,ymin,xmax,ymax,x2,y2,10,10,630,470,xp2,yp2); LineTo ( xp1 , yp1 ) ; LineTo ( xp2, yp2 ); end; Aria := Aria + x2 * sy1 - sx1 * y2 ; TRANSF ( xmin,ymin,xmax,ymax,sx1,sy1,10,10,630,470,xp1,yp1); LineTo ( xp1 , yp1 ); Aria := Aria / 2 ; Str ( Aria : 12:4 , sir ) ; OutTextXY ( 5 , 5 , ' ARIA : ' + sir ); end; readln; Close ( f ); CloseGRAPH; end.
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PROGRAM DEMONSTRATIV == C++ ==



//program Aria_Domeniu #include "graphics.h" #include  #include  #include  #include  #include  #include  #include "Str.h" struct punct { float x1,x2,y1,y2; }; //Variabile FILE* fp; punct rec; char nume[14]; int gd, gm, n; int xp1,xp2,yp1,yp2; float xmin, ymin, xmax, ymax; float Aria, sx, sy, sx1, sy1; char ch; char sir[10]; void TRANSF ( float xmin,float ymin,float xmax, float ymax, float x, float y, int x0, int y0, int x1, int y1, int& xp, int& yp) { // transforma coord. utilizator in coord. ecran float dx, dy; int hx, hy; dx hx xp yp



= = = =



xmax x1 x0 + hy -



- xmin ; dy = ymax x0 ; hy = y1 floor ( ( x - xmin y0 - floor ( ( y -



- ymin ; y0 ; ) / dx * hx ) ; ymin ) / dy * hy ) ;



} void main() { cout > nume; fp = fopen(nume,"r"); Aria = 0.0; xmin = 0 ; ymin= 0 ; xmax = 1000 ; ymax =1000; gd = DETECT; gd = 0;
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www.ad-astra.ro/marinvlada initgraph(&gd, &gm, "C:\\BORLANDC\\BGI"); rectangle ( 1, 1, 639, 479 ); settextstyle ( 1, 0, 2 ); setcolor(15); n = 0; while(fp) { if(n == 0) { TRANSF( xmin,ymin,xmax,ymax,rec.x1, rec.y1,10,10,630,470,xp1,yp1); moveto ( xp1,yp1); sx1 = rec.x1 ; sy1 = rec.y1; sx = rec.x2 ; sy = rec.y2; } else { Aria = Aria + sx * rec.y1 - rec.x1 * sy ; sx = rec.x2 ; sy = rec.y2 ; } n++; Aria = Aria + rec.x1 * rec.y2 - rec.x2 * rec.y1 ; TRANSF( xmin,ymin,xmax,ymax,rec.x1,rec.y1,10,10,630,470,xp1,yp1); TRANSF( xmin,ymin,xmax,ymax,rec.x2,rec.y2,10,10,630,470,xp2,yp2); lineto ( xp1 , yp1 ) ; lineto ( xp2, yp2 ); Aria = Aria / 2 ; itoa ( Aria, sir ,10) ; outtextxy ( 5 ,15 , " ARIA: " + sir); } fclose(fp); closegraph(); }



OBSERVATII: Ref. http://www.cplusplus.com/reference/clibrary/cstdlib/itoa/



itoa function  char * itoa ( int value, char * str, int base );



Convert integer to string (non-standard function)Converts an integer value to a nullterminated string using the specified base and stores the result in the array given by str parameter.If base is 10 and value is negative, the resulting string is preceded with a minus sign (-). With any other base, value is always considered unsigned. str should be an array long enough to contain any possible value: (sizeof(int)*8+1) for radix=2, i.e. 17 bytes in 16-bits platforms and 33 in 32-bits platforms. Parameters value - Value to be converted to a string. str Array in memory where to store the resulting null-terminated string. base
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Return Value A pointer to the resulting null-terminated string, same as parameter str.



Portability This function is not defined in ANSI-C and is not part of C++, but is supported by some compilers. A standard-compliant alternative for some cases may be sprintf: • • •



sprintf(str,"%d",value) converts to decimal base. sprintf(str,"%x",value) converts to hexadecimal base. sprintf(str,"%o",value) converts to octal base.



Example 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18



/* itoa example */ #include  #include  int main () { int i; char buffer [33]; printf ("Enter a number: "); scanf ("%d",&i); itoa (i,buffer,10); printf ("decimal: %s\n",buffer); itoa (i,buffer,16); printf ("hexadecimal: %s\n",buffer); itoa (i,buffer,2); printf ("binary: %s\n",buffer); return 0; }



Output: Enter a number: 1750 decimal: 1750 hexadecimal: 6d6 binary: 11011010110



See also sprintf Write formatted data to string (function) atoi Convert string to integer (function) atol Convert string to long integer (function)
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A N E X E - Referinte How to Program in C++ • •



http://www.cs.fit.edu/~mmahoney/cse2050/how2cpp.html Documentatie – functii primitive – winbgim http://marinvlada.googlepages.com/Library_winbgim.PDF (PDF) Compilatoare de C++ / Windows: •



Visual C++ .NET 2003



Free Software: Dev-C++: http://www.bloodshed.net/devcpp.html MinGW Developer Studio: http://www.parinyasoft.com/



How to Program in Dev-C++ & Graphics Creating 2D graphics programs under DOS is easy if you’re using [turbo c].There is library file called graphics.h that does the tiresome work for you.But unfortunately this library is borland specific you can’t use it on other compilers.Even though some peoples somehow managed to port it outside the turbo.Some people hacked their own version of graphics.h.One such person is Micheal main,he ported some of borland graphics functions and library. Micheal main modified BGI library for windows application to be used under MinGW.This BGI library is renamed as WinBGIm.Now you can use all the borland specific functions under Dev-C++.You can access this library from [Here]. If you want, you can Download the WinBGIM Devpack from this link[here] and start coding instead of using method below. Installation In order to run graphics programs under Dev-C++ you have to download WinBGIm files.Download the files listed below. Graphics.h (download to C:\Dev-Cpp\include) libbgi.a(download to C:\Dev-Cpp\lib) Once you download the files.Now you have to place into the correct location in Dev-C++ installation folder.Try to locate include and lib folder under your dev-cpp
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www.ad-astra.ro/marinvlada installation.Move these files under the respective folder of include and lib. like e.g. D:\Dev-cpp\ include & D:\Dev-cpp\lib . Configuration At last you’ve downloaded & installed the WinBGIm,now you have to configure it to use under Dev-C++.You’ve to set some project options in Dev-C++ in order to run WinBGIm references properly. Follow the steps below to set proper project options for WinBGIm. 1. Go to the “File” menu and select “New”, “Project”,Choose “Empty Project” and make sure “C++ project” is selected.Give your project suitable name and click on “Ok”. OR 1. You can create individual C++” source file” instead of “project”.Go to the “File” menu and select “New Source File” OR Go to the “Project” menu and select “New File”. 2. Go to “Project” menu and choose “Project Options”. 3. Go to the “Parameters” tab. 4. In the “Linker” field, enter the following text: -lbgi -lgdi32 -lcomdlg32 -luuid -loleaut32 -lole32 5.Click “Ok” to save settings. Now you’ve done with the configuration for WinBGIm.Please make sure you’ve donw this step properly otherwise compiler will flag error. Testing & Debugging Now let’s write a small program to test how WinBGIm works.Here is the source code for the program.Type it down,save it with .cpp extension and compile and run to see the results. #include  #include  using namespace std; int main() { initwindow(800,600);
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This is the program for displaying circle with respective parameters on window of size 800×600.This window will close when you press any key.If you’ve made settings correctly then you can view the graphics,without any problem. What’s included ? All the borland graphics batteries included,plus some additional written by other contributors of WinBGIm. With WinBGIm you can use most of the borlands graphics function & RGB colors.You can also use detectgraph() and initgraph() or you can use new function called initwindow().You can even use some of the old mouse function such as int mousex() & int mousey() along with getmouseclick() & clearmouseclick().For keyboard functions,you don’t have to include conio.h some of the functions are supported without it like void delay(int millisec),int getch( ),int kbhit( ). If you want to capture the screen where you’ve created your graphics.You can do it with help of these functions getimage(),imagesize(), printimage(), putimage(), readimagefile() ,writeimagefile(). Help & Support If you’re into some trouble with installation & configuration,then please post your questions here.But please don’t post homework problems or your custom projects.Google groups is the right place to get answers in such cases.You can even get lot of support with WinBGIm and Dev-C++ at Google groups.If you want to read about the WinBGIm documentation & FAQ then please point yourself [ Here ]. If you’ve any question or suggestion then don’t hesitate to post it here.If you know any alternative than WinBGIm,please post about it here.



#include #include #include #include



   



int main(void) { /* request auto detection */ int gdriver = DETECT, gmode, errorcode; int midx, midy; int radius = 100; /* initialize graphics and local variables */ initgraph(&gdriver, &gmode, "");
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www.ad-astra.ro/marinvlada /* read result of initialization */ errorcode = graphresult(); if (errorcode != grOk) /* an error occurred */ { printf("Graphics error: %s\n", grapherrormsg(errorcode)); printf("Press any key to halt:"); getch(); exit(1); /* terminate with an error code */ } midx = getmaxx() / 2; midy = getmaxy() / 2; setcolor(getmaxcolor()); /* draw the circle */ circle(midx, midy, radius); /* clean up */ getch(); closegraph(); return 0; }



DEV C++ http://usuarios.lycos.es/charlytospage/dev.htm (Carlos Fernando Jiménez) Dynamic Link Library - Hyper64 DLL: http://fozi.codingcorner.net/tutorials/h64pt/



#include "h64.h" int CALLBACK WinMain (IN HINSTANCE hInstance, IN HINSTANCE hPrevInstance, IN LPSTR lpCmdLine, IN int nShowCmd) { Hyper64 gfx; // tentar abrir o h64.dll int32 ret = gfx.loadDLL(); if (ret < 0) { switch(ret) {



Conf. Dr. Marin Vlada, Universitatea din Bucuresti



www.ad-astra.ro/marinvlada case -1 : MessageBox(0, "h64.dll não foi encontrado...", "Error", MB_OK|MB_ICONERROR); break; case -2 : MessageBox(0, "versão errada do dll...", "Error", MB_OK|MB_ICONERROR); break; default : MessageBox(0, "erro desconhecido...", "Error", MB_OK|MB_ICONERROR); } return (-1); } // inicializar uma janela gfx.initwindow(640, 480, 32, false, "h64app"); // ciclo principal while (gfx.doevents()) { // preencher o ecrã com uma cor azulada gfx.fill(gfx.rgb(128, 128, 255)); } // fechar a janela gfx.close(); // libertar o h64.dll gfx.freeDLL(); return (0); }



#include  int main() { char stringa="Asse x"; initwindow(300,300); outtextxy(100,100,"Asse x"); outtextxy(100,100,stringa); return 0; }



modelo RGB



• • •



R ou Red: Rosu G ou Green: Verde B ou Blue: Albastru



//Primo caso //Secondo caso
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http://deathray.us/code/color_output.html 1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35 36 37 38



#include  using namespace std; int main (int argc, char const *argv[]) { const char COL_RESET[] = "\x1b[0m"; // Foreground colors const char RED[] const char GREEN[] const char YELLOW[] const char BLUE[] const char MAGENTA[] const char CYAN[] cout cout cout cout cout cout cout



<< << << << << << 



RED << GREEN << YELLOW << BLUE << MAGENTA << CYAN << "This text



are in form of 3x, bacground are 4x = "\x1b[31m"; = "\x1b[32m"; = "\x1b[33m"; = "\x1b[34m"; = "\x1b[35m"; = "\x1b[36m";



"Red looks good" << endl; "Green looks good" << endl; "Yellow looks good" << endl; "Blue looks good" << endl; "Magenta looks good" << endl; "Cyan looks good" << COL_RESET << endl; should have the normal color" << endl;



// Cheap American flag, ASCII style. cout << "\x1b[44m" << "*********" << "\x1b[41m" << "=================" << endl; cout << "\x1b[44m" << "*********" << "\x1b[41m" << "=================" << endl; cout << "\x1b[44m" << "*********" << "\x1b[41m" << "=================" << endl; cout << "\x1b[44m" << "*********" << "\x1b[41m" << "=================" << endl; cout << "==========================" << endl; cout << "==========================" << endl; cout << "==========================" << COL_RESET << endl; return 0; }



Output
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Buffers



How to Program in Open GL http://lia.ufc.br/~wladimir/opengl/cg.htm The Red Book http://www.cs.rochester.edu/u/choman/cs290b/OpenGL/OpenGL.html http://www.iua.upf.es/~aramirez/docencia/infografia/index.html



LINKS:
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www.ad-astra.ro/marinvlada http://www.sgi.com/software/opengl/ http://www.opengl.org http://oss.sgi.com/projects/inventor/ ftp://ftp.sgi.com/sgi/opengl/ http://www.iua.upf.es/~aramirez/docencia/infografia/software.html



Bibliografíe Angel, E. “Interactive computer graphics: A top-down approach with OpenGL.” Addison Wesley, 2001. Watt, A. “3D computer graphics” (3ª edic.) Addison Wesley, 2000. Foley, J; vanDam, A.; Feiner, S. Hughes, J; Phillips, R. “Introducción a la graficación por computador”. Addison Wesley, 1996. Slater, M; Steed, A; Chrysanthou, Y. “Computer graphics and virtual environments”. Addison-Wesley, 2002 Buss, S.R. “3-D computer graphics: a mathematical introduction with OpenGL”. Cambridge U. press, 2003 Hearn Baker. “Computer graphics with OpenGL”. Pearson Prentice Hall, 2004



Links: http://www.opengl.org/ http://nehe.gamedev.net/ http://www.mesa3d.org/



Exemplu: // // fonte: The Red Book // ftp://ftp.sgi.com/sgi/opengl/opengl12.tar.Z // #include  #include  static GLfloat spin = 0.0; void display(void)



>> double.c
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www.ad-astra.ro/marinvlada { glClear(GL_COLOR_BUFFER_BIT); glPushMatrix(); glRotatef(spin, 0.0, 0.0, 1.0); glColor3f(1.0, 1.0, 1.0); glRectf(-25.0, -25.0, 25.0, 25.0); glPopMatrix(); glutSwapBuffers(); } void spinDisplay(void) { spin = spin + 2.0; if (spin > 360.0) spin = spin - 360.0; glutPostRedisplay(); } void init(void) { glClearColor (0.0, 0.0, 0.0, 0.0); glShadeModel (GL_FLAT); } void reshape(int w, int h) { glViewport (0, 0, (GLsizei) w, (GLsizei) h); glMatrixMode(GL_PROJECTION); glLoadIdentity(); glOrtho(-50.0, 50.0, -50.0, 50.0, -1.0, 1.0); glMatrixMode(GL_MODELVIEW); glLoadIdentity(); } void mouse(int button, int state, int x, int y) {



switch (button) { case GLUT_LEFT_BUTTON: if (state == GLUT_DOWN) glutIdleFunc(spinDisplay); break; case GLUT_MIDDLE_BUTTON: case GLUT_RIGHT_BUTTON: if (state == GLUT_DOWN) glutIdleFunc(NULL); break; default: break; } } int main(int argc, char** argv) { glutInit(&argc, argv); glutInitDisplayMode (GLUT_DOUBLE | GLUT_RGB);
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www.ad-astra.ro/marinvlada glutInitWindowSize (250, 250); glutInitWindowPosition (100, 100); glutCreateWindow (argv[0]); init (); glutDisplayFunc(display); glutReshapeFunc(reshape); glutMouseFunc(mouse); glutMainLoop(); return 0; /* ANSI C requires main to return int. */ }



Video Game Library http://www.geocities.com/garyneal_71/GameLib/index.html Graphics mode basics Graphics primitives ….



Using BIOS keyboard functions This sample program demonstrates the use of the BIOS functions from the CONIO.H library and how they can be use to create fast action programs. /* FastKey.C -- Demo on how CONIO.H functions can permit * fast action programming. * * by Gary Neal Jr. */ #include  #include "vmode.h"



/* Console I/O functions */ /* Video functions */



int main(void) { int X, Y, C, OldPixel, done = 0; int xdir = 0, ydir = 0; direct_video = 0; /* CONIO functions uses BIOS for output */ if (!SetVideoMode(VGA256)) { cprintf("Could not initialize VGA.\r\nAborting..."); return 1; } X = 160; Y = 100; C = 15; gotoxy(5, 0); cputs("Press [SPACE] to change color."); gotoxy(10, 20); cputs("Press [ESC] to quit.");
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www.ad-astra.ro/marinvlada while (kbhit()) getch(); while (!done) { if (kbhit()) { switch (getch()) { case 27: done = 1; break; case ' ': C = (++C) % ScreenColors; break; case '\0': { switch (getch()) { case 72: ydir = -1; xdir = 0; break; case 80: ydir = 1; xdir = 0; break; case 75: xdir = -1; ydir = 0; break; case 77: xdir = 1; ydir = 0; break; } } } } SetPixel(X, Y, OldPixel); X += xdir; Y += ydir; if (X >= ScreenWidth) X = ScreenWidth - 1; else if (X < 0) X = 0; if (Y >= ScreenHeight) Y = ScreenHeight - 1; else if (Y < 0) Y = 0; OldPixel = GetPixel(X, Y); if (!C) SetPixel(X, Y, 15); SetPixel(X, Y, C); } SetVideoMode(TEXT_MODE); return 0; }



Xiaolin Wu's line algorithm Xiaolin Wu's line algorithm is an algorithm for line antialiasing, which was presented in the article An Efficient Antialiasing Technique in the July 1991 issue of Computer Graphics, as well as in the article Fast Antialiasing in the June 1992 issue of Dr. Dobb's Journal. for the nearly-horizontal case (∆x > ∆y). To extend the algorithm to work for all lines, swap the x and y coordinates when near-vertical lines appear (for reference, see Bresenham's line algorithm). This implementation is only valid for x, y ≥ 0. function plot(x, y, c) is plot the pixel at (x, y) with brightness c (where 0 ≤ c ≤ 1) function ipart(x) is return integer part of x
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www.ad-astra.ro/marinvlada function round(x) is return ipart(x + 0.5) function fpart(x) is return fractional part of x function rfpart(x) is return 1 - fpart(x) function drawLine(x1,y1,x2,y2) is dx = x2 - x1 dy = y2 - y1 if abs(dx) > abs(dy) then //handle "horizontal" lines if x2 < x1 swap x1, x2 swap y1, y2 end if gradient = dy / dx // handle first endpoint xend = round(x1) yend = y1 + gradient * (xend - x1) xgap = rfpart(x1 + 0.5) xpxl1 = xend // this will be used in the main loop ypxl1 = ipart(yend) plot(xpxl1, ypxl1, rfpart(yend) * xgap) plot(xpxl1, ypxl1 + 1, fpart(yend) * xgap) intery = yend + gradient // first y-intersection for the main loop // handle second endpoint xend = round(x2) yend = y2 + gradient * (xend - x2) xgap = fpart(x2 + 0.5) xpxl2 = xend // this will be used in the main loop ypxl2 = ipart(yend) plot(xpxl2, ypxl2, rfpart(yend) * xgap) plot(xpxl2, ypxl2 + 1, fpart(yend) * xgap) // main loop for x from xpxl1 + 1 to xpxl2 - 1 do plot(x, ipart(intery), rfpart(intery)) plot(x, ipart(intery) + 1, fpart(intery)) intery = intery + gradient repeat else //handle "vertical" lines same code as above but X takes the role of Y end function
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